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Question: 1

Note: This question is part of a series of questions that use the same scenario. For your convenience,
the scenario is repeated in each question. Each question presents a different goal and answer
chokes, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four
workbook queries load the datasets to a data model. A sample of the data is shown in the Data
Sample exhibit.
Data Sample exhibit:
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
• DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a
log entry is created for each workshop, even if no hours or revenue are recorded for that day. Total
Hours and Total Revenue column.
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• Workshops have a list of all the workshops and the current and previous workshop managers. The
format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest
column indicates that the workshop manager listed in the record is the current workshop manager.
• RepairTypes has a list of all the repair types
• Dates has a list of dates from 2015 to 2018
End of repeated scenario.
When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot
generates the following error message: “The relationship cannot be created because each column
contains duplicate values. Select at least one column that contains only unique values”.
You need to ensure that you can create a valid relationship between the tables.
What should you do?

A. In the Power Pivot model, change the data type for Workshop[ID] to General
B. In the workbook query for Workshops, add an index column
C. In the Power Pivot model, change the Table Behavior setting for Workshops
D. In the workbook query for Workshops, filter [IsLatest] to equal 1

Answer: C

Explanation:
References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx

Question: 2

DRAG DROP
Note: This question is part of a series of questions that use the same scenario. For your convenience,
the scenario is repeated in each question. Each question presents a different goal and answer
choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four
workbook queries load the datasets to a data model. A sample of the data is shown in the Data
Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx
https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx
https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)



Questions & Answers PDF Page 9

https://www.certkillers.net

The tables in the model contain the following data:
• DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a
log entry is created for each workshop, even if no hours or revenue are recorded for that day. Total
Hours and Total Revenue column.
• Workshops have a list of all the workshops and the current and previous workshop managers. The
format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest
column indicates that the workshop manager listed in the record is the current workshop manager.
• RepairTypes has a list of all the repair types
• Dates has a list of dates from 2015 to 2018
End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of
the previous month, as shown in the following exhibit.
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Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the
appropriate fields to the correct targets. Each value may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Answer:

Explanation:
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IF (ISBLANK[(Total Hours]),BLANK(), CALCULATE([total Hours], DATEADD(tblDates(Date), -1,MONTH)))

Question: 3
HOTSPOT
Note: This question is part of a series of questions that use the same scenario. For your convenience,
the scenario is repeated in each question. Each question presents a different goal and answer
choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four
workbook queries load the datasets to a data model. A sample of the data is shown in the Data
Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:



Questions & Answers PDF Page 12

https://www.certkillers.net



Questions & Answers PDF Page 13

https://www.certkillers.net

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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The tables in the model contain the following data:
• DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a
log entry is created for each workshop, even if no hours or revenue are recorded for that day. Total
Hours and Total Revenue column.
• Workshops have a list of all the workshops and the current and previous workshop managers. The
format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest
column indicates that the workshop manager listed in the record is the current workshop manager.
• RepairTypes has a list of all the repair types
• Dates has a list of dates from 2015 to 2018
End of repeated scenario.
To the Dates table, you need to add a calculated column named Months Ago. Months Ago must
display the number of calendar months before the current month. For example, if the current date is
July 10, 2017, the Value of Months Ago will be 0 for all the dates in July 2017, 1 for all the dates in
June 2017, and 2 for all the dates in May 2017.
How should you complete the DAX formula? To answer, select the appropriate options in the answer
area.
NOTE: Each correct selection is worth one point.
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Answer:
Explanation:

Explanation:
Box 1: MONTH
Box 2: TODAY
References:
https://msdn.microsoft.com/en-us/library/ee634914.aspx
https://msdn.microsoft.com/en-us/library/ee634567.aspx
https://msdn.microsoft.com/en-us/library/ee634554.aspx

Question: 4

Note: This question is part of a series of questions that use the same scenario. For your convenience,
the scenario is repeated in each question. Each question presents a different goal and answer
choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four
workbook queries load the datasets to a data model. A sample of the data is shown in the Data
Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

https://msdn.microsoft.com/en-us/library/ee634914.aspx
https://msdn.microsoft.com/en-us/library/ee634914.aspx
https://msdn.microsoft.com/en-us/library/ee634914.aspx
https://msdn.microsoft.com/en-us/library/ee634567.aspx
https://msdn.microsoft.com/en-us/library/ee634567.aspx
https://msdn.microsoft.com/en-us/library/ee634567.aspx
https://msdn.microsoft.com/en-us/library/ee634554.aspx
https://msdn.microsoft.com/en-us/library/ee634554.aspx
https://msdn.microsoft.com/en-us/library/ee634554.aspx
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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The tables in the model contain the following data:
• DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a
log entry is created for each workshop, even if no hours or revenue are recorded for that day. Total
Hours and Total Revenue column.
• Workshops have a list of all the workshops and the current and previous workshop managers. The
format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest
column indicates that the workshop manager listed in the record is the current workshop manager.
• RepairTypes has a list of all the repair types
• Dates has a list of dates from 2015 to 2018
End of repeated scenario.
You create a measure named Average Revenue Per Hour that calculates the average revenue per
hour.
You need to populate a cell in a worksheet to display the Average Revenue Per Hour where Repair
Type is Engine.
Which Excel formula should you use?

A. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”,
CUBEMEMBER (“ThisWorkbookDataModel”, “[Dimensions]. [Repair Type]. [Engine]”))
B. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER
(“ThisWorkbookDataModel”, “[Dimensions]. [Repair Type]. [Engine]”))
C. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”,
CUBEMEMBER (“ThisWorkbookDataModel”, “[RepairTypes]. [Repair Type]. [Engine]”))
D. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER
(“ThisWorkbookDataModel”, “[RepairTypes]. [Repair Type]. [Engine]”))
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Answer: B

Explanation:
References:
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-
84a8f00dcbe0
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_fu
nction.htm

Question: 5

DRAG DROP
You merge several CSV files by using Query Editor.
You need to remove all the leading whitespaces and all the non-printable characters from a column.
What should you do to achieve each task? To answer, drag the appropriate actions to the correct
goals. Each action may be used once, more than once, or not at all. You may need to drag the split
bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Answer:

Explanation:
Box 1: From the Extract menu, click Trim

https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_function.htm
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_function.htm
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Box 2: From the Extract menu, click Clean

Question: 6

You have the Excel worksheet shown in the exhibit.

You need to transform the data by using Query Editor.
What should you do first?

A. From the Data tab, Click From Table/Range.
B. From the Insert tab, Click Store.
C. From the Data tab, Click Flash Fill.
D. From the Data tab, Click Consolidate.

Answer: A

Explanation:
Excel uses a dedicated Query Editor to facilitate and display data transformations. When you select
Data > Get Data, then select the data source, such as a workbook, or a database, the Navigator
window appears so you can select which table (or tables) you want to use in your query. When you
select a table, a preview of its data is shown in the right pane of the Navigator window.
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-
a8HYPERLINK "https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-
2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US"310388-2a12-438c-
9d29-c6d29cb8df6a?ui=en-USHYPERLINK "https://support.office.com/en-us/article/getting-started-
with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-
US&ad=US"&HYPERLINK "https://support.office.com/en-us/article/getting-started-with-get-
transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-

https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
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https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
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https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
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Question: 7

HOTSPOT
You have a workbook query that uses an Excel data source. The data source contains the following
table.

You need the data to appear as shown in the following table.

https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9d29-c6d29cb8df6a?ui=en-US&rs=en-US&ad=US


Questions & Answers PDF Page 23

https://www.certkillers.net

How should you transform the data from Query Editor? To answer, select the appropriate options in
the answer area.
NOTE: Each correct selection is worth one point.
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Answer:

Explanation:
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Box 1: User and UserID
Box 2: Unpivot Columns
References: https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-
49c1-9d95-f588221c7098

Question: 8

You have multiple workbook queries that load data from tables in Microsoft Azure SQL Database to a
Power Pivot data model.
You discover that new rows were added to the tables in Azure SQL Database.
You need to ensure that the workbook has the new data.
Why should you do?

A. Select a cell in the worksheet and pressF5.
B. From the data tab, click Refresh All.
C. Close and open the workbook.
D. From the Power Pivot tab, click Update All.

Answer: B

Explanation:
Refresh data from a Microsoft Query, the Data Connection Wizard, or web query
Click any cell in the range or table that contains the link to the external data.
On the Data tab, in the Connections group, click Refresh All.

To update only the selected data, click Refresh.
You can also right-click a cell in the range or table, and then click Refresh.
To update all the data connections in the workbook, click Refresh All.
Note: If you have more than one workbook open, you'll need to repeat the operation in each
workbook.
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Question: 9

DRAG DROP
You use a workbook query to import a table named Customers that contains a column named
CustomerName. CustomerName has names in the format of Lastname, Firstname.
You need the CustomerName column to contain names in the format of Firstname Lastname. A space
must separate Firstname and Lastname.
Which two commands should you use? To answer, drag the appropriate fields to the correct areas.
Each field may be used once, more than once, or not at all. You may need to drag the split bar
between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Answer:

Explanation:
https://support.office.com/en-us/article/split-a-column-of-text-power-query-5282d425-
6ddHYPERLINK "https://support.office.com/en-us/article/split-a-column-of-text-power-query-
5282d425-6dd0-46ca-95bf-8e0da9539662"0-46ca-95bf-8e0da9539662
https://support.office.com/en-us/article/merge-columns-power-query-80ec9e1e-1eb6-4048-b500-
d5d42d9f0a8d

Question: 10

You have an Excel workbook query that loads data to a worksheet and the data model.
You need to ensure that the data is refreshed whenever you open the workbook.
What should you do?

A. From the File tab, click Option, and then modify the Data option.
B. From the File tab, click Options, and then modify the General options.
C. From the Data tab, click Queries & Connections, and then edit the properties of the query.
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D. From the Power Pivot model, modify the Table Behavior setting.

Answer: C

Explanation:
https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-
wiHYPERLINK "https://support.office.com/en-us/article/refresh-an-external-data-connection-in-
excel-2016-for-windows-1524175f-777a-48fc-8fc7-c8514b984440"ndows-1524175f-777a-48fc-8fc7-
c8514b984440

Question: 11

You have an Excel workbook that has the following two workbook queries:
A query named consultants that retrieves a table named Consultants_Contact from a Microsoft SQL
Server database
A query named employees that retrieves a table named Employee_Contact from a Microsoft Azure
SQL database
Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table.
Which command should you use?

A. Transpose
B. Append Queries
C. Merge Queries
D. Combine Binaries

Answer: B

Explanation:
Append is similar to UNION ALL in T-SQL.
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

Question: 12

You have two queries named Client and Invoices. A sample of Client is shown in the following table.
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A sample of Invoices is shown in the following table.

You need to create a new table that has the following information.

Which join kind should you use?

A. Inner
B. Left Outer
C. Right Anti
D. Left Anti
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Answer: B

Explanation:
https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joinHYPERLINK
"https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joins-in-power-query/"s-in-
power-query/
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